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Dear Customer, 
You have purchased a product that meets the highest quality and product standards. However we are 
still obliged to inform you that we cannot accept any liability for the accuracy and completeness of the 
contents. Although the contents may be compiled carefully and accurately we cannot accept any lia-
bility for printing and transcription errors in particular. 
 
This manual and the hardware/software described within are protected by copyright. Any use outside 
of the standard application as defined in law is forbidden without the permission of the holder of rights. 
This specifically applies to copying, translation, publication (also in part), and input to electronic sys-
tems. 
 
This manual contains the technical specifications and product information according to the latest status 
before publication. 
The contents of this manual and the technical data for the products may be changed without prior 
notice. 
All hardware and software names used in this book are the protected trademarks of the manufacturer 
and must be treated as such. 
 
 

Service and Support 
 
If questions cannot be answered in our manual, please contact us: 
 
E-Mail  service@dr-horn.org 
Tel.:  +49 7031 6302-0 
Address Dr. E. Horn GmbH 

   Im Vogelsang 1 
   71101 Schoenaich 
   Germany 
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1 Introduction 

Dear Customer, 

 

Thank you for purchasing the “CPM - mobile Cylinder Pressure Monitoring” set. 

Please read the instruction manual prior to use and adhere to the guidelines so that you can work with your meas-

urement device safely. 

2 Intended Use 

This measurement device is suitable for measuring the internal cylinder pressure and conducting ultrasonic meas-

urements of two-stroke and four-stroke engines within and during operation. 

The user is liable for all damage resulting from the device being used in a way that does not comply with intended 

use. 

Generally accepted accident prevention regulations and the attached safety instructions must be complied with. 
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3 Description of Components 

The set consists of the listed parts below. Please check the completeness of the set upon receipt. 

1 x Hard shell case 

1 x Handset 

1 x Cylinder pressure sensor (permanently connected to handset) 

1 x Charger 

1 x Battery (inside of handset) 

4 x Adapter for on-shore connection/on-board supply system for charger 

1 x Tool to release the cylinder pressure sensor 

1 x Ultrasonic sensor 

1 x Connecting cable for ultrasonic sensor/handset 

Data transfer cable 

1 x RJ 45 Port 

1 x USB Port 

1 x Software to install on PC 

1 x Instruction manual 

 

 

 

3.1 Description and Technical Data 

Hard shell case: H x L x W ca. 420 x 480 x 115 mm 

CPM 7.0 kg / 15,43 lbs 

Humidity max. 75 % 

Working temperature -20…+55 °C 

Storage temperature -20…+30 °C 
Do NOT store in a discharged condition ! 

 

The case is fitted with an inherently stable plastic insert for storing the entire handset. 

Handset: H x W x D ca. 238 x 109 x 42 mm 

To measure the internal cylinder pressure when the engine is running, the range of measurement is limited 

between 0 and 300 bar; the speed of rotation limits are between min. 20 and max. 2000  
�

��� . 

Ultrasonic measurement, this function can measure relevant engine noise during operation. 

Start button controls the following functions: Turning the equipment on and off 

Deleting data memory 

Initiating measurement 

Terminating measurement 
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Three LEDs showing the state of the measurement unit: Measurement standby 

Running measurement 

Measurement finalization 

Low battery alert 

Deleting storage 

The dual-colored LEDs indicate these functions with the status ON, OFF or blinking (Table 10-1). 

Power is supplied by means of the 7.4 VDC rechargeable battery provided and inserted. 

Port for charger is located at the bottom (see Chapter 4.3 and page 6 graphic 2.4). 

The handset has a memory that can store the measurements of at most 24 cylinders, and can be connected to a PC 

for the data transmission of the measurements via an RJ 45 socket or USB (page 6 graphic 2.3). 

 
 
 
Cylinder Pressure Sensor 

Pressure range / overload: 0… 300 bar / 400 bar 

Frequency: 2 kHz 

Supply voltage: 18…32 VDC 

Output signal: 4…20 mA 

Operating temperature 
Max. medium temperature: 

-40…+75 °C 
+300 °C 

Protection degree (IEC 60529) IP 65 

 

  
Attention!  
The sensor is permanently connected to the handset. Disconnecting 
the sensor from the handset will result in losing warranty!  

 

 

Charger 

System voltage: 100 … 240 VAC 
Frequency: 50/60 Hz 
Power consumption:  maximal 9.62 W 
Protection class: IP 30 

Battery 

Nominal voltage: 7.4 V 

Capacity: 2200 mAh 

Power: 17 Wh 

Adapter 

The set includes 4 adapters for the charger. These adapters fit to the most common power supply systems. There 

might be some incompatibility with the power system in some countries. In such cases other adapters may need 

to be used. 
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Release Tool 

The key is only intended to release the cylinder pressure sensor from the indicator cock. The adapter has to be 

tightened with a maximum of 25 Nm; no mounting or fixing tool is necessary for this. 

 

Ultrasonic Sensor 

A passive sensor able to receive ultrasonic waves. The sensor is connected to the handset via a connecting cable 

(page 6 graphic 2.1). 

Dimensions: W x L x H ca. 38 x 136 x 22 mm 

System temperature min./ max.: -50…+100 °C 

Connection: 2-pole plug 

Output signal: 0…10 VDC 

 

Connecting Cable for ultrasonic sensor / handset 

Cable: triaxial cable with EMV shield 

Length: 1200 mm 

Connection: 2-pole plug 

 

Data Transfer Cable 

The data transfer cable is required to transmit the measurement data from the handset to the PC. 

Connection Port Length Reference page 7 

RJ 45 2000 mm Socket 2.3a 

USB  2000 mm Socket 2.3b 

The end of the cable has a protective cover made of steel to prevent any damage to the plug. 

 

Software (on CD or by download) 

The software needs to be installed on a PC/Laptop/Notebook to read out, transfer and anaylse the monitored and 

recorded data. 

 

Handbook 

The handbook is intended to assist you during installation, initial start up, and while measuring. 

 
Check the scope of your delivery as regards completeness and condition! 

 

4 Initial Start-Up 

The CPM comes with a built-in battery. Charge the battery completely and monitor the state of charge as described 

under 4.3 and following pages. Turn on the handset by pressing the START button (2 sec.). The LED POWER 

shining green. The handset is now ready for use. 
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The cylinder pressure sensor is mounted and can be used without any further measures. 

The assembly of the ultrasonic sensor has to be done. To do so, see also chapter 5.3 connecting the sensors. 

To install the software, see chapter 7. 

 

4.1 Charger/ Battery 

The CPM comes with rechargeable batteries for mobile use. The batteries are lithium-ion batteries, with no memory 

effect, low self-discharge and deep discharge protection. 

4.1.1 Changing the Rechargeable Batteries 

To change the batteries, loosen both screws at the bottom and remove the lid.  

Caution! The sockets remain attached to the lid. The cables are long enough 

For the battery to be removed out of the casing without difficulty. Disconnect 

the power between battery and handset and only use rechargeable batteries,  

furnished with an identical plug, or you'll risk reverse polarity and the handset will be damaged. 

  
Attention! 
Only replace rechargeable batteries with an original spare part. Batteries 
are hazardous waste and do not belong in the household waste. 

 

4.2 Charger 

Prior to use, compare the indicted data of the charger and check it corresponds to the system voltage and system 

frequency available. 

The charger is specially made for lithium-ion batteries, use only this charger to recharge the batteries. Prior to use, 

check the bottom of the charger for proper settings, charging voltage 8.2 V (graphic 4-1), and if necessary correct 

it using the yellow setting-wheel (arrow must point to 8.2 Volts). 

                                                                                                                          

 

 

 

 

 

 

Setting-wheel for charging voltage, 

arrow must point to 8.2 Volts 

 

Lever to release the adapter 

 

4.2.1 Changing the Plug 

Included in the delivery are 4 adapters for the charger that can be used for most common power supplies (page 6 

graphic 6). Choose the most suitable one and change it by sliding the lever on the bottom part of the charger (labelled 

OPEN) in the direction of the arrow (graphic 4-1). 

 
Figure 4-1 charger 
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The adapter will be ejected. The right adapter needs to be placed in the fixture and pressed down, until it audibly 

clicks into place and tightly anchors to the charger. Pay attention to the mounting direction as the adapter will only 

fit in one position. 

 

 

 

 

 

4.3 Connecting the Charger 

First, connect the charger by plugging the plug of the charging cable into socket 2.4 at the bottom of the handset. 

The plug will only fit if the red dots on the plug and those on the socket line up. Right after that, the charger may 

be connected to an appropriate socket. 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.1 Status of Charging 

When power is supplied by mains connection, the green LED POWER at the front of the charger will glow; it 

displays the functional status of the charger. The yellow LED CHARGE also comes on when charging and when 

the rechargeable battery is connected. Once the battery is fully charged, the yellow LED goes out and only the green 

LED shines. 

  
Attention!  
Only the right plug ensures the requisite level of safety! The charger is 
made to operate only in closed rooms and should not be used outdoors. 
 

 

 

Red dots need to be/form a line 

 

 

  

Figure 4-2 plug connection charger for handset 
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The green LED displays “Stand by” status; 

the charger is connected to the power supply. 

 

The yellow LED displays “Charge” status. 

When it is ON, the battery is charging. When 

it is OFF, the battery is fully charged. 

Figure 4-3 Significance of LEDs of the charger 
 
 

5 Getting Ready to Take a Measurement 

Before beginning to measure, a few points need to be considered and addressed. This will ensure that the measure-

ments can be performed without any problem and that the measurement results are comparable and useful and to 

ensure that the measurement device functions reliably and that the evaluation of the measurement data can be done 

free of errors. 

 

 

 

5.1 Marginal Conditions 

Prior to measurement, ensure that the conditions are exactly the same as they were during the previous measurement. 

These include:  

Same engine load point  

If possible, lock the governor (comply with the safety concept) 

On ships, pay attention to a calm sea 

No measurement during rudder motion 

With power stations, pay attention to constant load decrease 

 

 

 

 

 

 

  
Attention!  
Cylinder pressure measurements should only be conducted on stationary 
load points, since varying load points falsify measurement results. 
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5.2 Setting-up the monitoring device 

LED 1 = Power 

LED 2 = Cycle 

LED 3 = Status 

 
 

Turning the device on: Press the START button for 2 seconds. Once the LED 1 is green, the handset is ready. If 

LED 1 is red, this means that the battery is low. If the battery voltage drops even more, the device will switch off 

itself automatically. The battery may need to be recharged prior to measurement. 

Deleting memory: Press the START button for 2…5 seconds. LED 1 and 3 will indicate green. Release the START 

button. Pressing the START button again confirms the delete process and LED 3 indicates red while deletion takes 

place. LED 3 is off once the delete process has ended. If you do not confirm the delete process, it will stop after 

about 3 seconds and LED 3 will switch off again. 

 

 

 

 

 

 

 

 

5.3 Con-

necting the Sensors to the Measuring Device 

  
Attention!  
The cylinder pressure sensor is permanently connected to the handset. Disconnect-
ing the sensor from the handset will result in losing warranty! 

 

The ultrasonic sensor is mounted to the top part of the handset (socket 2.1, page 6). The plug-connection is not a 

screw, so it will latch itself. It will unlatch if you pull on the plug, but not on the cable. The same type of connection 

can be found between the cable and ultrasonic sensor. Only when both red dots line up can the plugs are connected. 

 

 

To connect                                                    

To  separate  

  
Attention!  
Owing to limited memory capacity and to avoid mixing up measurement data, you 
have to delete the memory every time before you take the first measurement. 
 

  

Note! 

You can find a complete summary of the meaning of the LEDs in the ap-

pendix:  

Table 10-2  Significance of the LEDs. 
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Note! 
The ultrasonic sensor cable is a cable especially tuned for this 
particular sensor. In the event of damage, do not replace it with 
another one. Please contact for assistance. 

 
 

 

 
Attention! 
Sensors, cables and the handset are highly sensitive measure-
ment instruments. That is why you should never pull on a cable 
and why you should treat sensor, cable and handset with care! 
 

 

 

5.4 Preparation of the Measurement Points 

Before the actual measurement takes place, all metering points have to be prepared to protect the device from being 

destroyed by fouling and to obtain good measurement values. 

To do so, clean the threads of indicator cocks using a wire brush or some other appropriate tool and blow through 

to ensure that any fouling in the indicator cock does not damage the cylinder pressure sensor when carrying out 

measurements later. These preparatory measures will save you time when carrying out measurements. 

  
Attention!  
Hot gas and solid component parts will come out at high pressure when the indicator 
cock is opened. Step aside before you open it, 
do not hold your head right above the indicator cock, and do not look into the open-
ing as long as substances can come out of the indicator cock. 
 
Please comply with occupational health and safety measures and wear protective 
goggles and gloves while operating a running engine. 
 
All parts within the appliance can be so hot that they may seriously injure you. 
 

 

A level surface at the cylinder head is needed for the ultrasonic sensor. The surface must be free of dirt and paint. 

Thanks to magnets, the sensor is self-adhesive. To obtain exact measurements, the ultrasonic sensor must be 

mounted directly on the cylinder head – not on the cylinder liner and not on the engine block. A small amount of 

oil, used as coupling medium, should be applied between the ultrasonic sensor and area of measurement. 

Figure 5-1 Connection of ultrasonic sensor and handset 
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Figure 5-2: Cutaway of cylinder head and ultrasonic 
sensor. Place sensor, as  shown in the picture, on top of 
a level surface 

 

 

Cylinder head 

 

 

 

 

Ultrasonic sensor 

 

 

 

One by one, the measurement data are stored on a memory card. These data cannot be sorted. Therefore, it is essen-

tial to number the cylinders. The most suitable thing would be to use the cylinder numbering system offered by the 

manufacturer, which is found in the engine manufacturer's manual. Begin with the first cylinder station and work 

your way up, step by step, through to the last cylinder station. 

 

  
Attention! 
Keep to the proper sequence, beginning with the first cylinder station 
all the way to the last as measurement values cannot be interchanged! 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

D r . E .  H o r n  G m b H ,  G e r m a n y   C P M  
 

P a g e  1 6  

 

 

 

MAN  

Exhaust Side 
 
 
CCS                                                                                                        CS 
 
 
Control Side 
 
 

 

Wärtsilä  

Exhaust Side 
 
 
CCS                                                                                                       CS 
 
 
Control Side 
 
 

 

V-Engines MAK / Caterpillar 

Side A 
 
 
 
 
CCS                                                                                                    CS 
 
 
 
 
Side B 
 
 

Figure 5-3 Counting methods for MAN, Wärtsilä and MAK engines 

 

 

Special Features of V Engines 

For measurements using a V-engine, begin on bank A at the cylinder station 1 and then measure the entire bank. 

Only then should you start to carry out measurements on bank B in the same order. 

 

  

2 1 3 4 5 

1 2 3 4 5 

6 7 8 9 10

4 5 3 2 1 
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6 Carrying Out Measurements 

6.1 Cylinder Pressure Measurement 

Cylinder pressure measurement is an essential diagnostic tool to monitor the status of the engine and its individual 

cylinders. To do so, the march of pressure of all strokes is measured and represented. 

The measured data is transferred into a diagram with cylinder pressure over the degree of the crank angle [°CA]. It 

represents a curve, from which the following points regarding supervision and state-based maintenance can be an-

alyzed: 

Start of compression 

Slope of compressibility curve 

Height of compression pressure 

Start of combustion 

Maximum cylinder pressure  

Opening and closing of valves 

 

 

6.1.1 Carrying Out Cylinder Pressure Measurements 

For a safe and rapid measurement, it is necessary that the measurement point preparations as outlined in chapter 5.4 

have been completed and the handset has been prepared. The measurement begins at the first cylinder station and 

is to be conducted according to the following structure: 

- Check that the battery is charged (see Chapter 4.3). 

- Attach sensors to the handset (see Chapter 5.3). 

- Delete memory (see Chapter 5.2). 

- Determine cylinder station number 1 (see Figure 5-3). 

- Using the belt, hang the handset over your shoulder so you will have one free hand. 

- Position yourself in front of the cylinder head in such a way that you can safely reach the indicator cock. 

- Screw the cylinder pressure sensor clockwise (hand-screwed max.). If the sensor is screwed on too tightly, it will 

be damaged. If the sensor is too loosely, it can come off and shoot off owing to the cylinder pressure of the 

indicator cock. This constitutes a serious risk of injury! Position yourself next to the indicator cock, not in front 

of it and not above it! 

- Turn on the handset by pressing the START button for 5 seconds. LED 1 will glow green. 

- Fully open the indicator cock, using the appropriate tool. No gas must be permitted to escape from between sensor 

and indicator cock. 

- Wait approx. 15…20 seconds with the first cylinder to ensure that the sensor can warm up. 

- Briefly press the START button (LED 1 and 2 will glow green). 

- Measurement begins (If you briefly press the START button, you can manually terminate this measurement.). 

- When LED 2 switches off, the measurement has finished and the data is recorded. 
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- The device is ready for the next measurement, if LED 1 only is green. 

- Close indicator cock. 

- Unscrew cylinder pressure sensor. You may have to use the tool provided. Do not hit it with a hammer or a similar 

object. 

- Repeat step 6 to 16 for all remaining cylinder stations. 

- Turn the device off after all measurements have been completed. Press the START button for little more than 6 

seconds or until all LEDs have gone out. 

 

 

 
Attention!  
While measuring, make sure you are safely positioned. The rule of thumb of "one 
hand for the ship, the other hand for me" applies here. 
Position yourself next to the indicator cock and not in front of it or above it. 
Comply with health and safety procedures and accident prevention regulations! 
 

 

  
Attention! 
Write down the charge air pressure as it needs to be entered into the software by hand. 
 

 

 

 

LED 1 and 2 indicating green light, means that the device is measuring the cylinder pressure. The measurement 

time depends on the engine and rotational speed. There is an overview of the measuring time in Table 6-1. 

 

 

 

 

 

 

 

 

 

 

 

 

Rotational Speed [1/min] Engine Total Time of Measurement [s] 

20 2 stroke 88 

150 2 stroke 20 

250 4 stroke 22 

1000 4 stroke 13 

1500 4 stroke 12 

2000 4 stroke 12 

Table 6-1 Times and Cycles to Determine Sampling Rate 
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6.2 Explanations Regarding Cylinder Pressure Measurements 

 

 

Figure 6-1 Cylinder Pressure Curve 
 

Description of Figure: 

Cylinder pressure, in bar (1 bar = 100,000  
�
��	 = 0.1 MPa), is located on the vertical axis, on the left-hand side. The 

piston path is displayed in degree of crank angle [°CA] and is located on the horizontal axis, lower limit. The curve 

shows an open p/α diagram. 

Conversion of crank angle to path: 

�	
� � 	
 �	1 � ���
� � �4		1 � ���2
�� 
s = piston path   r = upstroke radius 

λ = connecting rod ratio  α = crank angle 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 2 3 4 5 
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With 2-stroke engines, the pressure range of –180 °CA to +180 °CA is displayed. This corresponds to 360 °CA = 

one engine revolution = charge exchange + compression stroke + power stroke. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

EO = exhaust valve opens 

EC = exhaust valve closes 

IO = inlet opens 

IC = inlet closes 

TDC = top dead centre 

BDC = bottom dead centre 

Valve Timing Diagram, Two Stroke Engine 

                                  TDC  0° 

 

 

 

 

 

 

 

BDC  -180° / 180° 

 

 

 = power stroke 

      0...180 °CA 

 = compression stroke

     –180…0 °CA 

 = injection duration 

 

 = charge changing 

Power Stroke Diagram, Two Stroke Engine 

EO 
IO 

TDC 

BDC 
IC 

EC 

Rotational 

direction 

90° -90° 

  PMS 

0/° 
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With 4-stroke engines, the pressure range from –180 °CA to 540 °CA is displayed. This corresponds to 720 °CA = 

two engine revolutions = compression stroke + power stroke + exhaust stroke + induction stroke. 

 

 

 

 

 

 

180° 

 

 

 

                       TDC 1   0° 

 

EO = exhaust valve opens 

EC = exhaust valve closes 

IO = inlet opens 

IC = inlet closes 

TDC = top dead centre 

BDC = bottom dead centre 

Valve Timing Diagram, Four Stroke Engine 

                       TDC 2   360° 

 

 

                                                                 540°/ 

180°                                                        -180°/ 

 

 

 

 

 

 = induction stroke 
    0…180 °CA 
 = compression 
stroke 
     180…360 °CA 
 = power stroke 
     360…540 °CA 
 = exhaust stroke  
     540…720 °CA 
 = injection duration 
 varies dep. on type 
 of injection system  

Power Stroke Diagram, Four Stroke Engine 

 

 

6.2.1 Diagnosis of the Cylinder Pressure Course 

Area 1, the process of cylinder pressure measurement begins at -180 °CA. The measured cylinder pressure corre-

sponds to the purging air pressure (charge air pressure) in this area. 

Area 2, begins at approx. 60 °CA before TDC. The pressure in the cylinder begins to rise due to the compression. 

Area 3, cylinder pressure reaches its compression pressure, which depends on: 

 

Charge air pressure (depends on the load point of the engine, the efficiency factor of the turbocharger or the blower 

- see performance diagram TC) 

Trapping ratio λ (depends on valve timing, status of the scavenging air slots, valves, and charging air pressure) 

The engine’s point of consumption (depends on rotational speed, torque at the crank shaft, injection filling - see 

the engine performance diagram) 

TDC 2   360° 

IO                 EC 

 

     540°/ 

    -180° 

  IC EO 

TDC 1   0° 

Rotational 

direction 



 

 

D r . E .  H o r n  G m b H ,  G e r m a n y   C P M  
 

P a g e  2 2  

State of the engine (depends on the state of the piston rings, valves, the piston, and the liner) 

 

The slope of the curve in area 3 should be steep and should reach the necessary compression pressure as specified 

by the manufacturer. You can find information on compression pressure in the engine operating data sheet diagram 

which was supplied by the manufacturer. 

In this area it is possible to make a statement regarding the overall state of the engine, or peripheral components. 

 

 
 
 

 
Attention!  
Measured pressures can deviate from the manufacturers’ data within a predefined range of 
tolerance. This is due to non-stationary load points, measurement errors, and the absence of 
ISO conditions. There can only be one or more worn or defective components if this tolerance 
range is not reached. 
 

 

Area 4, displays combustion pressure. Maximum cylindrical pressure should be reached here. The shape of the 

curve forms a bend after the compression pressure and then rises once again. For two-stroke engines, the slope of 

the combustion pressure should begin after TDC = 0 °CA. For four-stroke engines, the combustion pressure can 

begin before TDC. With good injection and combustion the curve will display an even gradient in this area. The 

level of combustion pressure and the shape of the curve depend on the following paramters: 

Compression pressure 

Begin of injection (depending on the setup VIT, pilot injection, 

       post-injection, and poly-injection) 

Injection pressure (depending on the state of the fuel pump) 

Injection duration 

Process of injection (depending on the state of injection nozzles 

       being coked or eroded, the opening pressure setting, drips) 

Many points can be diagnosed in this area. Amongst other things, quantitative and qualitative statements on the 

process of combustion can be formed using the exhaust temperature. 

Area 5, cylinder pressure decreases after combustion. The gradient of the curve should display an even descent in 

this area. At approx. 60 °CA before BDC (the point can vary depending on the engine valve timing), the curve will 

display a slight dent because the exhaust valve opens and the cylindrical pressure suddenly decreases. This area 

ends at 180 °CA for 2 stroke engines and at 540 °CA for 4 stroke engines. 

The cylinder pressure curve could portray slight waves in this area which inevitably evolve due to the reflection of 

pressure waves within the indicator cock. This is a typical occurrence and cannot be prevented due to physical laws 

of nature. 

6.3 Ultrasonic Measurement 

A running engine generates noise through movement, opening and closing of the valves, streaming gases, injection, 

combustion, deformations, etc. The noise spreads in the form of waves inside the engine and passes over into the 
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environment. The ultrasonic sensor measures these high-frequency waves and generates an analogue signal from 

them. The signal is amplified and all irrelevant frequencies (low-frequency) are filtered out so that in the end only 

the streaming of gas, injection with combustion, and the opening and closing of the valves, are contained in the 

measurement value. 

Attention! The ultrasonic measurement must be conducted at the same time as the cylinder pressure measurement. 

For this, the cylinder pressure sensor and the ultrasonic sensor must be attached to the measurement areas and to 

the handset. The procedure is the same as that described above for cylinder pressure measurement. The handset 

automatically recognizes the sensors and performs both measurements. Ultrasonic measurements cannot be per-

formed without cylinder pressure measurements. 

 

6.3.1 Carrying Out an Ultrasonic Measurement 

After you have prepared the measurement areas for the measurement as described under 5.4, proceed as follows: 

Attention!   Cylinder pressure measurement must be performed at the same time as ultrasonic measurement. The 

procedure for a cylinder pressure measurement is described under 6.1.1. The following describes just those steps 

necessary to conduct an ultrasonic measurement in addition to a cylinder pressure measurement. 

Connect the ultrasonic sensor to the handset (see Chapter 5.3 Connecting the Sensors) 

Clean the measurement area and apply some oil as a coupling medium 

Place the ultrasonic sensor with its active flat side level on top of the cylinder head, as shown in the illustration 

below 

The following steps are conducted as described in Chapter 6.1.1 beginning with step 4. 
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6.4 Explanation of the Ultrasonic Measurement Values 

 

 

 
Figure 6-2 Ultrasonic progression for two-stroke engines 

 

You can see the progression of the ultrasonic measurement (coloured red) in this picture. You can also see the 

cylinder pressure progression (coloured blue). The handset has triggered the time of measurement such that both 

measurements are displayed at the same time with regard to the crank angle. Cylinder pressure in bar is depicted on 

the left vertical axis (see the explanation of cylinder pressure measurement). The ultrasound is displayed on the 

right vertical axis. The path of the piston is displayed in °CA on the lower horizontal axis. 

6.4.1 Two-Stroke Engines 

In area 1, the even progression of the ultrasonic measurement is discernable, beginning at –180 °CA. The exhaust 

valve is open; flue gas is flowing out of the cylinder and scavenging air enters the cylinder through the opened inlet 

slots. At -140 °CA (the precise point can vary depending on valve timing), the scavenging air slots are closed – this 

process is not visible in the ultrasonic measurement. 

In area 2, the closing of the exhaust valve is discernable. 

In area 3, pressure losses are most evident. The flatter a line up to the slope and the steeper the first deflection the 

less leakage from the exhaust valve there is. In the figure 6-2, the valves are in good shape, sealing the combustion 

chamber with minimal loss. 

In area 4, the first peak indicates combustion. The fuel has been injected and combusted with strong noise devel-

opment. After the third peak, combustion slowly ebbs away. If the peak drops sharply and heads for the horizontal 

plane at almost a right angle as in the illustration above, this is a sign of excellent valves which seal off the com-

bustion chamber. 

In area 5, at 160 °CA (the moment can vary depending on the timing) and slightly in front of the lower dead point 

is a round-shape elevation on the red line, followed by a steep deflection. This specific elevation suggests the open-

ing of the exhaust valve. 

 

6.4.2 Four-Stroke Engines 

In area 1, an even progression of the ultrasonic measurement is discernable, beginning at –180 °CA. 

In area 2, the closing moment of the inlet valve is discernable at –150 °CA (the point may vary depending on the 

timing). The closure generates a powerful echo which is displayed as a large deflection. 

  1   2 3 4 5 
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In area 3, the pressure drops are most clearly discernable. The more even the gradient of the curve up to the slope 

and the steeper the first deflection climbs, the smaller the losses through the inlet/ exhaust valve. In the figure above 

the valves are in good condition, ensuring low-loss sealing of the combustion chamber. 

In area 4, the first peak indicates combustion; fuel was injected and burned, causing high noise emission. Combus-

tion slowly ebbs away after the second peak. When, as shown in the figure above, the peak drops sharply and then 

approaches the horizontal plane almost at right angles, it indicates very good valves sealing off the combustion 

chamber. 

In area 5, at 160 °CA (the point can vary depending on the timing) and slightly before the lower dead point, a round 

bump is visible on the red line. The bump indicates the opening of the exhaust valve. The exhaust valve closes at 

370 °CA (the point can vary depending on the timing) as indicated by a high deflection. 

 

 

Figure 6–3 Ultrasonic process in four-stroke engines 

 

 

7 Software 

The following description should make it easier for you to handle the software. The main areas are installation, 

evaluation of the data and storage of the measurements. 

7.1 Compatibility and Prerequisites 

The software supports Computer the Windows operating systems of Windows 2000 and later / newer. 

The following prerequisites must be fulfilled to install the software. 

Pentium IV processor or higher 

512 MB RAM or more 

Hard disc with at least 500 MB available storage 

Graphics card with resolution of 1024 x 768 (600) or higher 

CD-ROM drive 

Mouse 

RJ45 network communication port or USB port 

 

2 3 4 5 
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Take Care! 
Turn off your wireless network adapter before connecting the device 
with the PC via RJ 45 network cable! 
 

 

7.2 Software Installation 

The software must be installed on a PC for the measured values to be evaluated and stored. If received the installa-

tion file on CD, place the disk in the CD drive and open the folder. Select ”CPM Setup.exe” with a double click and 

follow the steps that are indicated. 

7.3 Configuring the software and the engine parameters 

Configuring the software serves to establish the proper settings of the engine parameters, the alarm threshold values 

of the engine and the circumstances under which measurements are taken. 

Double click on the program. Then the start menu appears. 

 

1 File| 2 Display| 3 Config|                                                         5 connection display 

 

Figure 7-1 Initial Page 

Click on Config [3] 

This opens the “EDIT ENGINE CONFIGURATIONS” window. Engine configurations have already been in-

stalled here. Now check the default settings and change them as appropriate. 

8 engine name                        9 engine type 

 

 
 
 
 
 
 
 
 
 
1 Edit 
2 Duplicate 
 
3 Delete 
 
4 Import 
5 Export 
 
6 Close 
 

Figure 7-2 Edit Engine Configurations Window 
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Use the mouse cursor or the cursor keys to select an engine whose settings you wish to check or change and then 

click the Edit button. 

This opens the “CPM SETTINGS” window. 

It is divided into the following 2 tabs. 

 

� ENGINE PARAMETERS, (to be opened first). The engine data listed below is entered here: 

 

Figure 7-3 Engine Parameters 

 

The name of the engine is displayed under ENGINE NAME, e.g. SKL. 

The engine type is displayed under ENGINE TYPE, e.g. VDS 8 29/24 AL 

Name and Type are also taken for the file name when measured values are stored and so they should be unique. 

The number of cylinders is set by scrolling or using the arrow keys. 

Click the “2 stroke” or “4 stroke” button, as applicable 

Enter the nominal speed [rpm], (MCR speed, not the CMCR speed!) 

Enter the nominal power [kW] (MCR power, not the CMCR power!) 

Enter the stroke in metres (see the engine manual for the value) 

Enter the bore (cylinder diameter) in metres (see the engine manual for the value) 

Enter the connecting rod length in metres (see the engine manual for the value). Enter the compression ratio (see 

the engine manual for the value) 

Enter the inlet and outlet value opening times as crank angle (degrees) for the first cylinder. 

 

� CPM SETTINGS. This is where the settings for taking measurements can be changed. 

 

 

 

 

  
Attention!  
TDC is the reference point and corresponds to a crank angle of  0°. Engine 
timings before TDC must be expressed with a minus sign. 
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1 Acoustic  
Emission  
 
Cylinder Pressure / 
Power 
3 Limit compr. 
5 Limit power 
 
Ultrasonic sound 
7 calcul. range 1 
(before TDC) 
8 calcul. range 2 
(after TDC) 

Figure 7-4  CPM settings 

 

2 Angle comp. 
pressure [deg.] 
 
4 Limit max 
 

6 Theoretical 
Injection Begin 

 

 

CPM settings 

 Measurements with/without ultrasonic sound: tick the box next to  ACOUSTIC EMISSION  if you take measure-

ments using ultrasonic sound. 

Angle compression pressure: if the engine’s injection time lies before TDC, select the crank angle as value; if the 

engine’s injection time lies after TDC, select zero. 

 

Cylinder Pressure Measurement and Power 

Limit Compression Pressure: how far away the alarm thresholds lie from average compression pressure. The 

recommended value is ± 3 bar. 

Limit Maximum Pressure: as with 3, but for maximum cylinder pressure. The threshold value should be at ±5 bar. 

 Limit Power: alarm threshold for average pressure. A threshold value of 5 % is recommended. 

Theoretical Injection Begin: injection begin for nominal load. For engines with injection begin before the upper 

dead point (TDC), the latter must be corrected downward (negative value). The value entered should correspond 

to injection begin for nominal load. Take the values from the manual for the engine. 

 

 
Attention! 
Erroneous entries can lead to incorrect results when the measured values are analysed. 

 

 

Ultrasonic sound Measurement 

Calculation Range 1 defines the range before TDC in which the leakage measurement is taken. Its lower boundary 

value (“begin”) should lie just after closure of the inlet value and its upper boundary value (“end”) should coincide 

with injection begin. 
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Take Note! 
Since the two angles for calculation range 1 lie before TDC, they 
must each be entered with a minus sign! 

 

Calculation Range 2 defines the measurement range after TDC. Its lower boundary value should lie just after 

conclusion of injection and its upper boundary just before the outlet valve is opened. 

7.3.1 Addition / Deletion of Engines to / from the Configuration 

Add Engines. The “EDIT ENGINE CONFIG” window can be used to add engines. For this, you need complete 

configurations that are stored on the CD. These are entered in the list with the Import button. Clicking on Import 

causes Explorer to open. Then you just have to click through the path in which the new engine configurations are 

located. The standard path is: C:\Program Files (x86)\Horn\CPM\Configurations. 

Select the desired engine type and confirm your entry with OK. 

Delete Engine. Open the “EDIT ENGINE CONFIG” window and select the engine you want to delete. When this 

engine’s background colour is blue, click on the Delete button. Then the engine is removed from the list. 

 

 

7.4 Software Description 

This section explains how to load the data and which other functions and possibilities are provided by the software. 

7.4.1 Loading Data 

From the handset. The measured values stored in the handset have to be transferred to the PC. To do this, start the 

“CPM” program on the PC. The following screen will appear: 

 

1 File| 2 Display| 3 Config| 4 Help                                         5 connection display 

 

Figure 7-5 Main Menu 

Connect the handset and the PC with one of the data transfer cables being delivered with the product. 

Using the Network-cable 

Insert the end with the metal sleeve into socket 2.3a (LAN port page 8) on the bottom of the handset until it locks 

in place. 

 

 

 

 

 

 

 

 

 
Take Note! 
1) The handset must be attached directly to the PC. While it is true 
that connections can also be made through a network, this data trans-
fer method is not supported by the software. 
 
2) It can take 30 seconds for the plug symbol to light up green. 

6   7 
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connect                                                            separate 
 

 
 
Push to separate 
 
 
Data cable plug 

Figure 7-6 Connection of Data Cable with Handset 

 
 
Insert the other end of the cable into the RJ 45 socket of the PC. Turn on the handset. The software recognizes the 

handset automatically and the data can be transferred via the Internet Protocol (IP). 

Using the USB-cable 

Insert the smaller plug into socket 2.3b (USB Port page 8) and the other one into a free socket of the PC. Right after 

Windows configured the USB device, the MarPrime software recognizes the handset and data can be transferred 

via USB. 

The connection display [5] on the upper right of the main menu indicates whether a handset is attached; this symbol 

must be lit green. 

 
Click on button 6, LOAD DATA FROM DEVICE, in the main window. This opens the “SELECT ENGINE CON-

FIG” window. Using the mouse cursor, select the engine whose measured values are currently stored in the con-

nected handset. Then click on the  <<Proceed>> button. This opens the “LOAD MEASFILE” window. Each of the 

individual cylinders is listed here together with the current data file name, which is based on the date and time, and 

file size. 

 

 

Check the value of scavenge air pressure [1]. Enter the scavenge air pressure via the keyboard. This is very im-

portant. The correct value of the scavenge air pressure must be entered if the measurements are to be analysed 

correctly. An incorrect value can lead to erroneous results! 

 
 
 

1 scavenge 
air pressure 
(must be entered 
manually) 

Figure 7-7 “Load Measfile” Window 

 
    

 
 
 
 
 
 
   2  
Remove 
File 
 
 
 
    3  
Load 
Files 
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Click on the Remove File button [2] to cause the selected record (with blue background) to be removed and all the 

following records to move up. 

Click on the Load Files button [3] to start the program. If the scavenge air pressure is less than 0.3 bar, first a new 

window will appear to ask for confirmation of the scavenge air pressure. If you select No, the value can then be 

corrected. If you select Yes, the program will be executed. 

 

Load Stored Data. In the main menu, select File[1] → load Data from file  or click on the Load data from file 

button [7]. Then Explorer opens with the stored data. Select the measurement file that you want and confirm this 

request by clicking the Open button. The cylinder pressure curves of the data selected are then displayed in the main 

menu. 

7.4.2 Analysing the Data 

When the data has been loaded, it is displayed in the main menu, where all the cylinder pressure curves of the 

measurement are displayed in graph form. 

  
Take Note! 
The maximum number of displayed cylinder pressure curves is the number of 
cylinders that was set in “Configuration”. For example, if a 6 cylinder engine 
is entered in the Configuration menu but 8 measurements (instead of just 6) 
are stored in the handset, only the first six measurements are displayed. 
 

 

 

Loads measurement data from 
your handset and start a new 
calculation 

 
Opens the bar charts 

 
Opens a previously saved 
measurement  

Opens the statistics 

 
Saves your calculation 

 
 

Opens ‘Probability of leakage 
from the bar charts 

 Opens the Overview  
Opens the pressure changing 
rate diagram 

 Opens the p/ α diagram  
Opens the report creator 

 
Opens the p/V diagram   

Table 7-1 Quick navigation with the button bar 
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                     1 Menu bar                  2 Name of engine                3 Engine speed [rpm] 

 

 
4 Date and time of measurement                                                               5 Cylinder 

Figure 7-8 SHOW OVERVIEW View 
 

[1] The menu bar shows the menu items File, Display, Config and Help and the buttons for these functions are 

arranged directly underneath it. 

[2] Shows the name of the engine that is now being displayed. 

[3] Shows the engine speed [rpm] when the measurements were taken. 

[4] Shows the date and time (GMT) of the handset when the data was measured as well as the name and path of 

the storage location. 

[5] The numbered buttons at the lower right (at most 24 buttons) are for the cylinder stations and can be clicked 

to cause the corresponding cylinder data to be faded in or out. 

Click menu item Display in the menu bar and then click p/α Diagram or else click the button [9] (Figure 7-9). A 

new window opens to display the individual pressure curves. Click the Theoretical Curve button [5] to see the 

theoretical compression curve. Clicking the Valves Timings button [3] fades in the valve timings that were set in the 

configuration. By clicking on the Reference button [6] you can then select another cylinder from the same measure-

ment to make comparisons. It is not possible to fade in a cylinder for comparisons from another measurement. 

With ultrasonic sound measurements the ultrasonic sound signals (Figure 1-9, red line) can be faded in and out by 

clicking on the Show Leakage / Hide Leakage button [10]. Clicking on the Leakage Window button [11] displays 

the windows in which the leakage measurement is made. 

Clicking on the arrow key button >> [7] at the bottom right closes or opens the table, with the main field becoming 

larger or smaller accordingly. The table at the right lists important data that belongs to the measurement. 
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 9  p/α Diagram   1 Leakage Window           3 Valve Timings        6 Reference Curve 

                           10 Hide Leakage               2 TDC/BDC               5 TheoreticalCurve 

 

 

                                                                                                    7  arrow key| 8 Table 

Figure 7-9 SHOW DETAILS with ultrasonic sound 

 

Speed is engine speed at the time of measurement 

p scav is air pressure at time of loading 

(scavenge pressure) 

p comp is compression pressure 

p max. is cylinder pressure = 

combustion pressure  

Angle max. is the crank angle at which cylinder pressure reaches its maximum 

value. 

Ind. Power is indicated power. Attention! This is not effective power; 

Probability of Leakage is the probability of pressure loss due to defective valves 

Delta Speed represents the speed difference within this measurement. 

Bad cycles shows the number of cycles which have been discarded from calcu-

lation. If this value is higher than two you should repeat your measurement. 

 

Point the mouse cursor at the diagram to get a vertical line on which the position on the pressure curve is displayed. 

When the mouse cursor is moved to the right or left, this line automatically moves along the curve and the corre-

sponding values are displayed in the table at the right. 

 

 
 
Figure 7-10  Table with the 
data of current cylinder 

Leakage Window 

Theoretic compres-

sion curve 
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Angle to TDC shows the position on the cylinder pressure curve. 

Pressure is cylinder pressure at this position on the curve. 

To see the cylinder pressure curve with pressure vs. piston displacement, click on 

menu item Display and then on p/v Diagram or else click on the button [1] 

(Fig.1-11). 

1 p/v Button                          2 Light Spring         3 TDC/BDC    4 X-Axis 

 
Figure 7-12 View of Pressure/ Volume Curve 

 

As in the p/α diagram, a table with the most important data is faded in on the right. When the mouse cursor is moved 

over the diagram, a vertical line appears to show the position on the curve and the table at the bottom right displays 

the corresponding data (Figure 7-13). 

Clicking on the Light Spring button [4] displays a diagram that shows the gas exchange cycle. Clicking the 

TDC/BDC button [3] fades in the piston turning points that delimit the stroke volume. The X-Axis selection menu 

[4] allows selection of the unit of the abscissa (x-value). Thus the volume can be displayed absolutely in cubic 

centimetres or relatively in %. Clicking on the Reference button allows comparison with another cylinder from the 

same measurement. It is not possible to fade in a second cylinder from some other measurement. 

 

Volume: the entire volume, Vh+Vc, which can be expressed in cm3 or 

as a %-value. 

Compression: pressure in the compression stroke 

Expansion: pressure in the expansion stroke 

Exhaust: pressure in the exhaust stroke 

Intake:  pressure in the intake stroke 

 

 
 
Figure 7-11  Table with the 
data of current cylinder 

 

Figure 7-13 Table with the data at the 
given position on the pressure / volume 
diagram 
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Take Note! 
With 2 stroke engines there are no exhaust and intake pressure values! 
 

 

Clicking on menu item Display and then on Display bar charts opens the next window. All bar chart diagrams have 

a table in which the graphic values are also stated numerically along with the average value over all the cylinders. 

Clicking on buttons 2 and 3 (Fig.7…14) fades in lines that mark the alarm thresholds, once for the compression 

pressure and once for maximum pressure. The alarm thresholds are set in the SETTINGS window (see page 44). 

 

                        1  submenu items       2 Limit p comp| 3 Limit p max.| 4  Mode 

 

Figure 7-14 Bar charts                 5 Table 

 

Selection of Mode [4]: the measured values can be presented in alternative forms. 

With Full Mode [4], the diagram is faded in from zero to the peak value. 

With Peak Mode [4], only the peak values are shown. This makes it easier to compare the peak value curves of the 

various cylinders. 

With relative Mode [4], the deviation from the average over all the cylinders is presented. This allows one to see 

at a glance how far the individual cylinders deviate from the average. 

 

Submenu Items [1]: 

Pressure is the first submenu item and is opened automatically. The maximum cylinder pressure (blue) and the 

compression pressure (green) are shown for all the cylinder stations. 

 Angle max. Pressure gives the crank angle at which the cylinder stations achieve maximum pressure. 

Mean Indicated Pressure gives the indicated average pressure of the individual cylinders. 

Power gives the maximum indicated power of all the cylinder stations. 

Engine Speed gives the engine speed at the time when the measurements were taken. The green bars stand for the 

lowest engine speed, the light blue bars show the average engine speed and the dark blue bars show the highest 

engine speed that was present when the measurements were taken. 
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Scavenge air pressure gives a diagram that shows the scavenge air pressure (load pressure) at the time “inlet valve 

just closed”. 

Horse Power gives the indicated power in units of “Brake horse power” (bhp). 

Probability of Leakage displays the computed probability of pressure loss due to defective valves. In the table below 

[5] (see Figure 7-145) this probability is expressed numerically. 

The valve button allows quick access to the leakage display from the main menu. (seeFigure 7-5). 

 

 

 

 

 

 

 

Clicking on menu item Dis-

play and then on Display Sta-

tistics opens a window with a 

summary of the pressure and 

power values that were meas-

ured and the probability of 

pressure losses. The column 

PROBABILITY OF LEAK-

AGE is only available when 

ultrasonic sound has been active when the measurements were taken. In all other cases “Leakage < 5%” is displayed. 

With the statistics table, the efficiency factor must be entered by hand in the field with arrow keys at the upper right 

corner. This number expresses the efficiency factor a %- value. 

 

  
Take Note! 
The efficiency factor is not a constant. It depends on the engine and must be 
entered again for each engine. The efficiency factor can be as low as 87% 
for fairly old engines and as high as 94% for new engines! 
 

 

 
Take Note! 
The %-values given for ultrasonic sound measurements give only the probability 
that a given valve is defective at all and not the percentage by which it is defective! 

 

Figure 7-15 Diagram of the Probability of Pressure Loss due to Defective Valves 

  
Take Note! 
The pressure rise ration pcomp/pscav is computed with absolute pressures and 
not with overpressures. All other pressures are given as an overpressure. 
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When is Valve Maintenance Required? 

Probability [%] Meaning and Recommendation 

0 – 40 
Bar is green: the valve is in good condition: no leakage present, no action 

required. 

40 – 80 

Bar is yellow: small pressure losses. 

Check at short regular intervals and with results near 80% or worse, take 

a second measurement and compare the results. 

80 – 100 Bar is red: the valve is defective and maintenance should be considered. 

 
Table 7-2 Meaning of and Action to be taken with Ultrasonic sound Measurements 

       1 Switch for average 
Figure 7-15 Changing Rate of Cylinder Pressure View 

Clicking the dp/dt- button will open a window showing the cylinder pressure curves overlaid by the curves of their 

pressure changing rate per degree. This window is similar to the overview window plus the “average”-button at the 

lower left. This button switches between the display modes normal and average for the changing rate curves. The 

average is a moving average about 5 values. 

 

7.4.3 Zoom and Move 

Zoom. This function makes it easier to see an excerpt of the points on the pressure curve. Just keep the left mouse 

key pressed while you move the mouse cursor from the upper left to the lower right of the area on the curve to be 

enlarged (at least 1cm x 1cm). To restore the original size, move the mouse cursor (with left mouse key pressed) 

from the lower right to the upper left of the enlarged area. 
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Move. The window can also be moved. This is especially useful in zoom mode because here only part of the entire 

curve is displayed. To move the image, keep the right mouse key pressed while you move the mouse cursor in the 

direction in which you want to move the image. 

7.4.4 Store Data 

Click on menu item File (in the menu bar) and then on menu 

item Save Data to File to open a window in which you can 

enter the path of the location in which the data is to be stored. 

If needed, create a new folder in which you would like to your 

measurements are to be stored. The name of the engine and 

date and time of the measurements are include in the file name 

automatically so that it is easy to find the measurements again. 

Confirm by clicking on the Store button. This causes the data 

to be stored. 

 

7.4.5 Exporting the Statistics Table 

The statistics table can be stored by clicking on the File menu item and then on Export Statistics. The standard target 

location is  C:\Program Files (x86)\Horn\CPM\Statistics 

The name of the engine that is currently open is automatically included in the file name. The table contains the 

measured values, which can also be found by clicking Display→ Display Statistics. 

 

7.4.6 Exporting diagrams 

If you like to export the actually displayed diagram you just need to click on the File menu and then on Export 

diagram. This opens a dialog which lets you choose where to save your diagram. The diagram will be saved as 

enhanced media file (*.emf). This means high quality at low space and can be viewed with Windows Picture Viewer. 

 

7.4.7 Print Report 

The Report is a statistical table that summarizes all the measurement results and all relevant data that was available 

when the measurements were taken. In addition to the temperatures of oil and cooling water, this data also includes 

wind direction, wind force, sea swell, etc. 

The report is created in the main menu by clicking on the Create Report button under the menu bar (the one at the 

far right) or on the File menu item and then on Create Report to open a new window for creating the report (Figure 

7-16). 

Now enter the name and initials of the report’s author (person preparing the report) under Name [7], Initials [8] and 

select the report template under Template [6]. The pressures that have been measured are filled in automatically so 

that only the fields for the corresponding environmental conditions still have to be filled in. Click on the Save 

button [2] to store the report temporarily and click the Print button [3] to output the report on paper if a printer is 

available. 
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1 Preview| 2 Save| 3 Print| 4 XML |5 Email| 6 Template|   7 Name|      8 Initials 

 

Figure 7-16 Create Report View 
 

The to XML [4] button enables you to save the report as an XML-sheet. 

The Mail button [5] supports transmission of the report through the Internet. For this you also need e-mail programs 

and access to the Internet. When the e-mail service is opened, the report and measured values are automatically 

attached. 

  
Take Note! 
It is not possible to send reports directly with Outlook Express. 
 

 

The Preview button [1] displays a preview of the current report. To store the report as a pdf file, click on the Preview 

menu item to open the PREVIEW window and look at the report. If you decide to store it as a pdf file, click the 

Export to PDF [1] button in the menu bar. To leave the PREVIEW window without storing the report, click the 

Close button [2]. 

 

1 PDF                                     2 close 

 

Figure 7-17 Preview of a Report 
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7.4.8 Export engine configs 

This function allows rapid transfer of engine configurations from one PC to another. This saves time and prevents 

data entry errors when defining engines on another PC. In addition, you can use this function to transfer configura-

tions from the registry to a folder of your choice which you can access at all times, particularly when you are 

installing software updates. 

Open the SELECT ENGINE CONFIGS window to select the engine whose configurations are to be exported. If the 

engine’s background colour is blue, clicking on the Export button will open the Explorer. Now select the path in 

which this engine’s configurations are to be stored. Confirm and execute the export process by clicking the Store 

button. 

 

7.4.9 Help 

By clicking on Help → Help you can find a detailed help that can assist you if you have any problems with using 

the software. 

 

7.5 Version 

The manufacturer reserves the right to prepare and release new and/or other 

versions of the software. The description of your version can be found in the 

main menu by clicking Help → Info. This opens a window with all  

information about the software. 
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8 After Use 

  
Take Note! 
Measurement devices are highly sensitive tools. For this reason, the CPM should be 
returned into the case provided after use. Do not throw the device and protect it from 
hard impacts and shocks. Temperatures outside the operating temperature range and 
moisture inevitably lead to damage to the device and expiration of the guarantee. 
 

 

9 Guarantee 

 
The manufacturer provides a 24 months guarantee for this product, beginning with the date of delivery. The delivery 

note is proof of guarantee. The warranty encompasses flawless manufacture and functional efficiency. Should de-

fects occur in this regard the manufacturer shall ensure replacement and repair in accordance with the following 

conditions: 

1. The device was not exposed to inappropriate use or incorrect treatment. 

2. The defect cannot be attributed to damage caused after delivery to the purchaser. 

3. No alterations or maintenance work were performed by unauthorised persons or which are not in agreement with 

the instructions provided. 

4. The defect cannot be attributed either wholly or in part to a cause outside of the device or to the connection of 

the device to other objects which are not intended for such a purpose. 

5. All transport and insurance costs involved in returning the device to the specialist dealer are to be paid in advance 

by the purchaser. 

6. The manufacturer or the specialist dealer shall bear the delivery costs incurred in returning the repaired device if 

the complaint was justified and the claim made within the guarantee period. If this is not the case, all costs incurred 

are to be borne by the buyer. 

7. The manufacturer accepts no liability above and beyond the warranty claims described above. 

8. This manual is subject to change or update without prior notice. Furthermore, all general terms and conditions of 

Dr.E.Horn GmbH apply. The general terms and conditions were provided with your delivery note and are available 

on www.dr-horn.org. 
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10 FAQ (frequently asked questions) 

Here, you can find possible problems, causes, and proposed solutions. If your question is not included in this table 

or the procedure does not help, please contact Dr.E. Horn GmbH by email: service@dr-horn.org 

 

 

  

Question / situation / error Cause Procedure 

LED does not illuminate after 

turning on the handset 

Battery voltage is too low Charge handset. 

Check the connection between battery and handset 

Software is running and shows no 

reaction on pressing the button 

Software of the device has 

stopped. 

 

Press the reset button. The reset button is located 

on the sensor side and can be reached by a needle. 

Battery voltage still not sufficient 

after charging 

Wrong voltage configuration 

on the charger 

 

Set the adjustment wheel on the charger to 8.2 V 

and charge again. 

Change the batteries. 

Battery defective 

Ultrasonic measurement values 

poorly displayed 

No oil between sensor and 

the measuring point 

Apply oil as coupling medium. 

Check cable connection. 

Repeat measurements. Paint or dirt between the sen-

sor and the measuring  point 

Faulty connection to handset 

 

Table 10-1  Error handling and frequently asked questions 
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10.1 Summary of the significance of the LEDs 

 

Item Holding time 
START key 

LED 
number 

LED colour Significance 

 
1 

 
1 s 

 
1= ON 

 
green 

when LED 1 illuminates the handset is on release the key for more 
actions 

 
 
 
 
2 

 
 
 
 

short 

 
 
 

1= ON 
2= ON 

 
 
 
 
green 

Briefly pressing the key starts a measurement 
Measurement is performed automatically 
LED 2 turns off when the measurement is finished 
Stop measurement by briefly pressing the key 

 
 
 
 
3 

 
 
 
 

2 s – 5 s 

 
 
 

1= ON 
3= ON 

 
 
 
green (red) 

LED 1 and 3 illuminate green 
Release the key and press it again within 2 sec to confirm the delete 
procedure 
LED 3 illuminates red during the delete procedure 
LED 3 (green and red) turns off once the procedure is complete 

 
4 

 
6 s 

1 = flashing  
green 

If key is now released the device will turn itself off 

Continuance Table 10-2 Significance of LED’s 
 
4 

 
6 s 

1 = flashing green If no input occurs the device turns itself off after 512 seconds 
 

 
5 

 1 = flashing red Handset operating on batteries, low voltage 
the handset turns itself off if the voltage decreases further. 

 
 
 
 
 
 
6 

 
 
 
 
 
 

short 

 
 
 
 
 

3= ON/ 
Flashing 

 
green 
 
 
 
 
red 
 
 
 
 
 
red 

 
LED 3 illuminates continuously, network connection active for read-
ing data 
 
If LED 3 is blinking (0.5 Hz), measurement was aborted because no 
cylinder pressure was measurable. Confirm message with START 
and LED 3 turns off 
 
If LED 3 is flashing (1Hz) the measurement was not saved because 
the memory is full 
The message is confirmed by pressing the START button and LED 
3 turns off 

 
Table 10-2  Significance of the LEDs 
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11 Description of the features in version 3.2.1 

Send file 

By clicking  File  →  Send file to  a dialog opens with the buttons Send via email and Open path. 

• Click on  Send via email  opens your standard E-Mail client. Addressed person, subject and the current 

MPD-file are automatically filled in. 

• Click on  Open path  opens the Horn folder where you can find the data files (*.mpd). 

Extract config from measurement 

By clicking  File  →  Extract config from measurement  a configuration window opens. The engine parameter of 

the current measurement data file (*.mpd) are automatically filled in the corresponding fields. By clicking the  OK 

-button a new configuration file will be saved and can be used for further analyses. 

Send raw data 

By clicking  Help  →  Send raw data  a window opens where you can choose raw data files for sending to Dr. E. 

Horn GmbH. The raw data are subdivided in engine type and date of measurement. Before sending the raw data are 

packed in the zip-format. 

• Click on  Send via email  opens your standard E-Mail client. Addressed person, subject and the chosen raw 

data (*.zip) are automatically filled in. 

• Click on  Open path  opens the Horn folder where you can find the raw data files (*.zip). 

Search for updates 

By clicking  Help  →  Search for updates  the Horn software checks if a new update is available. Therefore a 

connection to the internet is required. 

A click on the  OK -button starts the download. After finishing the download you have to install the “horn_up-

date.exe” to update your Horn software. 

 

Fine tuning 

After loading measurement data from your handheld device and finishing the calculation process you have the 

possibility to manually adjust the TDC (Top Dead Centre). You are allowed to shift each cylinder pressure curve 

up to +/- 1.5 °CA at 0.1°CA steps. Select one or more cylinders to be shifted at the same time. For an optimized 

TDC correction use the derivative of the measured curve and the derivative of the theoretical compression curve. 

By clicking the Reset -button the initial conditions will be set again. After saving your measurement a second TDC 

correction is not possible anymore. 

Remarks 

By clicking  Display  →  Display remarks  or clicking “R” in the toolbar the remark window opens. The remark list 

gives you a quick overview about specific events and a hint if something is not ok. There are three types of remarks. 

The first tells you how the measurement was carried out. (e.g. number of cylinders measured, quality of ultrasonic 
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sound signals etc.) The second type checks whether the measurements exceeded limits or not. Those limits can be 

set within the corresponding engine configuration (e.g. pressure deviation, leakage detection etc.). 

History 

By clicking  Display  →  Display history  or clicking “H” in the toolbar the history window opens. All measurement 

files found in the measurement folder (…\Horn\Measurements) can be selected to be shown in the history tool. Any 

other folders including subfolders are ignored. 

You can select and compare up to two engines with up to 10 measurement files each. When selecting only one 

engine you can compare different measurement values for the same measurements. When selecting two engines you 

can compare different measurement values between the measurements of those two engines. 

By clicking on one of the measurement points (dots) displayed in the diagram you can open this measurement file 

in a new program window for more information. 

Display options: 

• Dots → displays the values for each measurement and each cylinder 

• Lines → connects the dots for each cylinder in the same color 

• Average → displays the average value of each measurement 

• Limits → displays the default measurement limit value 

View mode: 

• Normal → displays the absolute values 

• Relative to average → displays the difference between absolute values and the average 

12 Notes on Safety and Surrounding Area 

Before working on the system, disconnect the power. Always wear clean clothing, and have clean hands and tools. 
Only use tools suitable for this work. All other safety instructions are valid and should be observed. 
 

13 Warranty Declaration 

The manufacturer's product warranty is valid for 24 months from the date of delivery. The delivery note is the valid 
document. The warranty covers error-free processing and functional capability. If deficiencies occur in relation to 
this, the manufacturer provides a replacement or repair provided that the following conditions are met: 
1. The device has not been used improperly or subject to incorrect treatment. 
2. The deficiency is not due to damage caused after receipt of the delivery by the customer. 
3. No modifications or maintenance work has been carried out by unauthorized persons or work which does not 
comply with the given instructions. 
4. The deficiency is neither totally or partially due to causes external to the device or due to the connection of the 
device with other unapproved or inappropriate objects. 
5. All transport and insurance costs for the return of the device to the retailer are paid in advance by the customer. 
6. The postal charges for return of the repaired device are paid by the manufacturer or retailer if the notice of defects 
is legitimate and within the warranty period. If this is not the case, the costs for processing, delivery and insurance, 
as well as the costs for repair or replacements are charged to the customer. 
7. There is no obligation on the part of the manufacturer outside of the warranty claims described above. 
8. This manual can be changed or updated at any time without prior notice. The General Terms and Conditions are 
also valid. 
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14 Ownership Information 

is a registered trademark of Dr.E. Horn GmbH. 

 

15 Copyright 

© 2015 Dr. E. Horn GmbH. All rights reserved. 

This manual and the information contained within, including extracts, must not be reproduced, 
copied, transmitted, transferred, saved to a data processing system, or translated into another lan-
guage without written permission from the manufacturer. 

This manual has been compiled with great care. However, if you should find any errors, please contact us. 

 


